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LEGAL DISCLAIMER AND CONDITION OF USE 
This document contains information for the SHOUT nano and SHOUT nano-BTI personal 

satellite tracking devices and accompanying accessories (“Product”), which are provided “as is.” 

Reasonable effort has been made to make the information in this document reliable and 

consistent with specifications, test measurements and other information. However, NAL 

Research Corporation and its affiliated companies, directors, officers, employees, agents, 

trustees or consultants (“NAL Research”) assume no responsibility for any typographical, 

technical, content or other inaccuracies in this document. NAL Research reserves the right in its 

sole discretion and without notice to you to change Product specifications and materials and/or 

revise this document or withdraw it at any time. User assumes the full risk of using the Product 

specifications and any other information provided. 

NAL Research makes no representations, guarantees, conditions or warranties, either express 

or implied, including without limitation, any implied representations, guarantees, conditions or 

warranties of merchantability and fitness for a particular purpose, non-infringement, satisfactory 

quality, non-interference, accuracy of informational content, or arising from a course of dealing, 

law, usage, or trade practice, use, or related to the performance or nonperformance of any 

products, accessories, facilities or services or information except as expressly stated in this guide 

and/or the Product and/or satellite service documentation. Any other standards of performance, 

guarantees, conditions and warranties are hereby expressly excluded and disclaimed to the 

fullest extent permitted by the law. This disclaimer and exclusion shall apply even if the express 

limited warranty contained in this guide or such documentation fails of its essential purpose. 

In no event shall NAL Research be liable, whether in contract or tort or any other legal theory, 

including without limitation strict liability, gross negligence or negligence, for any damages in 

excess of the purchase price of the Product, including any direct, indirect, incidental, special or 

consequential damages of any kind, or loss of revenue or profits, loss of business, loss of privacy, 

loss of use, loss of time or inconvenience, loss of information or data, software or applications or 

other financial loss caused by the Product (including hardware, software and/or firmware) and/or 

the Iridium satellite, or arising out of or in connection with the ability or inability to use the 

Product (including hardware, software and/or firmware) and/or the Iridium satellite to the fullest 

extent these damages may be disclaimed by law and whether advised of the possibilities of such 

damages. NAL Research is not liable for any claim made by a third party or made by you for a 

third party. 
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ACRONYM LIST 
AES .............................Advanced Encryption Standard 

AT ...............................ATtention (from the original Hayes modem AT Command set) 

BIS ..............................Bureau of Industry and Security 
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DISA ............................Defense Information Systems Agency 
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ETSI .............................European Telecommunications Standards Institute 

FCC .............................Federal Communications Commission 

FDMA .........................Frequency Division / Multiple Access 

GPS .............................Global Positioning System 

HACC ..........................Horizontal Accuracy 

HDOP ..........................Horizontal Dilution of Precision 

IC ................................Industry Canada 

IMEI ............................International Mobile Equipment Identification 

IP ................................Internet Protocol 

LCD .............................Liquid Crystal Display 

LED .............................Light Emitting Diode 

Li-ion ...........................Lithium-ion 

NOC ............................Network Operation Center 

OFAC ...........................Office of Foreign Asset Controls 

PDOP ..........................Position (3D) Dilution of Precision 

PIN ..............................Personal Identification Number 

PMS ............................PECOS Message Structure 

POP .............................Post Office Protocol 
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RUDICS .......................Router-based Unrestricted Digital Internetworking Connectivity Solution 

SatTerm ......................Satellite Terminal Emulator software 

SBAS ...........................Satellite-Based Augmentation System 

SBD .............................Short Burst Data 

SMTP ..........................Simple Mail Transfer Protocol 

TBR .............................Time-Between-Reports 

TDD .............................Time Division Duplex 

TDMA .........................Time Division / Multiple Access 

USB .............................Universal Serial Bus 

UTC .............................Coordinated Universal Time 

Vvel.............................Vertical Velocity 

VDC .............................Volts (Direct Current) 

VDOP ..........................Vertical Dilution of Precision 
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1 INTRODUCTION 
The SHOUT nano is a handheld, global, two-way satellite messaging and personal tracking 

device. It utilizes Iridium’s Short Burst Data (SBD) service to provide location information 

determined by a Global Positioning System (GPS) receiver, two-way inbound and outbound 

status, text messaging, and emergency/alert notifications. The SHOUT nano-BTI is a variation of 

the original SHOUT nano. It functions the same as the SHOUT nano, but also is designed with a 

Rugged Screen Protector. 

NOTE: Unless otherwise noted, all references to the SHOUT nano apply to the SHOUT nano-BTI. 

The SHOUT nano significantly improves service reliability over existing tracking products by 

allowing two-way communications and confirmation of the nature of the distress to the first 

responder community. This reduces false alerts; helps identify the nature of the emergency so 

that the correct assets can be deployed, thereby reducing search and rescue costs; and 

provides communications feedback capability to the user to assist in rescue efforts. The SHOUT 

nano is 100% backward compatible with the SHOUT. 

The SHOUT nano is designed with ultra-low power consumption electronics drawing less than 

35 μA during sleep. With an internal 1.95 Ah rechargeable Li-ion battery and depending on the 

environmental conditions, it can send a position report every ten minutes for more than ten 

days (more than 1,500 reports). Read Appendix C: Power Consumption to learn about the 

impact of blocked antennas on the number of reports. The SHOUT nano is equipped with a 

high-resolution color Liquid-Crystal Display (LCD) and on-screen keyboards, allowing 

transmission of free-text, canned messages, and a combination of free-text and canned 

messages. The menu options are displayed as icons for quick access. The device can periodically 

wake up from sleep to send its position report to a command center. A 911 button is used for 

immediate emergency/alert notifications. Data are packaged in either standard or 256-bit 

Advanced Encryption Standard (AES) encrypted format. 

The SHOUT nano is capable of sending position reports in PECOS Message Structure (PMS). The 

PMS complies with the Blue Force Tracking Data Format Specification. The SHOUT nanos are 

shipped without PMS features activated and can only be enabled by NAL Research at the 
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request of an authorized user. Functions related to PMS can be found in Appendix A: PMS 

Features. 

The SHOUT nano offers a variety of services including: 

• Normal Tracking — The SHOUT nano can be programmed to automatically wake up and 

send a position report at a set interval ranging from once every minute to once a day. 

• Emergency Alert — When the emergency 911 button is pushed, the SHOUT nano 

immediately sends alerts to a designated corporate email, home email, and/or 

monitoring center. The home base and the user can then communicate to define 

further specifics of the situation and a response to the emergency. 

• Free-Text Messaging — The SHOUT nano allows users to send free-text via three 

different sets of on-screen keyboards. 

• Canned Text Messaging — The SHOUT nano allows users to send canned (predefined) 

messages. Up to 600 predefined messages stored in memory can be retrieved and sent. 

Sending canned messages saves bandwidth (effectively cost) because only short codes 

are transmitted to the server instead of the entire message body. 

• Waypoint Tracking — The SHOUT nano lets users send and/or save waypoints for later 

retrieval. A waypoint is a GPS location that a user wants to identify and mark with a 

specific name tag for future reference. 

• Check-In — The SHOUT nano allows a quick check-in message to be sent using a single 

soft key. 

IMPORTANT: NAL Research can enable the SHOUT nano for use on the Department of Defense 

(DoD) Enhanced Mobile Satellite Services (EMSS) Gateway. However, accessing the EMSS 

Gateway is not authorized until the SHOUT nano is provisioned (signed up for airtime). 

Unauthorized attempts to access the EMSS Gateway will result in immediate disabling of the 

offending device, which must then be returned to NAL Research for repair. Please see webpage 

https://emss.pac.disa.mil/home.shtml  for more information regarding DoD EMSS service 

provisioning. This is a U.S. Government Information System website, and can only be accessed 

by authorized users with a valid certificate.  

https://emss.pac.disa.mil/home.shtml


This document contains NAL Research proprietary information which may not be 
used, reproduced, or disclosed without written approval from NAL Research 

 SHOUT nano User Guide Version B 

Document Number: 451-92681-001B 14 of 61 

IMPORTANT: Do not disassemble the SHOUT nano for repair or services. The warranty is void if 

the SHOUT nano is disassembled. Return it to NAL Research for services by calling 703-392-

1136 x203 or emailing contact@nalresearch.com. 

mailto:contact@nalresearch.com
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2 USING THE SHOUT NANO 
2.1 DEVICE DESCRIPTION 
The SHOUT nano has eight buttons, one Light-Emitting Diode (LED), and a Universal Serial Bus 

(USB) port (see Figure 1). The buttons are used to power up the device, access the menus for 

parameter setting, initiate Check-In and Way Point functions, and activate emergency 

notification. The USB port is for charging, firmware update, and parameter setting. 

 
Figure 1: SHOUT nano Buttons, LED, and USB Port 

1. Power/Enter:  

a. Turns device on or off when held down for two seconds or 

b. Selects highlighted item on a menu. 

2. Arrows: 

a. Up/Down/Right: Navigates the cursor. 

b. Left: 

i. Navigates the cursor or 

ii. Returns to the previous menu. 

3. Check-In Soft Key: Accesses the Check-In feature. 

4. Way Point Soft Key: Accesses the Way Point features. 
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5. USB Port: Charges the battery, updates firmware, and sets up operating parameters 

using a computer. 

6. Emergency: Sends an emergency 911 alert/notification. 

7. Guard: Protects emergency button from being accidentally activated.  

8. LED: Displays tracking and emergency statuses. 

9. Antenna: Embedded GPS antenna (DO NOT BLOCK). 

10. Antenna: External Iridium antenna* (DO NOT BLOCK). 

*IMPORTANT: For best performance, NAL Research only recommends the use of the Maruwa 

decafilar antenna. Performance degradation, including dropped coverage and shortened 

battery life, can occur if a different antenna is used. NAL Research will void the warranty if the 

SHOUT nano is replaced with a non-Sarantel antenna. 

2.2 CHARGING THE BATTERY 
The SHOUT nano package includes an AC wall adapter and a standard USB-to-mini USB cable. 

The SHOUT nano is shipped with its internal lithium-ion battery partially charged. Fully charge 

the SHOUT nano before use.  

There are two ways of charging the SHOUT nano.  

• Use the supplied AC wall adapter. The charging time is approximately five hours. 

• Connect to a standard USB device—make sure to use the USB cable provided with the 

SHOUT nano. Charging time using a USB port depends on the type of USB port.  

o USB 1.0 should be able to charge the SHOUT nano in about a day, assuming the port 

is capable of producing an output current of 100 mA.  

o USB 2.0 can charge the SHOUT nano battery in about four hours, assuming a 

current output of 1.5 A.  

NAL Research offers 12 Volts (Direct Current) (VDC) and 24–36 VDC chargers sold as separate 

items. While using the SHOUT nano, a low-battery warning message appears when remaining 

power is less than 10%. 
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The SHOUT nano has a battery status icon  at the top-right corner of its LCD screen 

indicating the charging status. When charging is complete, the icon shows five bars (not 

counting the last battery icon). The device can be safely operated and does not need to be 

turned off while charging, but the charging cycle completes quicker when the device is turned 

off. 

2.3 BASIC NAVIGATION 

• Turn on the SHOUT nano by holding down the power/enter  button for 

approximately two seconds.  

• Once the device is on, use the arrow  buttons to position the cursor over menu 

icons. 

• Use the enter  button to select the highlighted icon. 

• Each menu has a BACK  button, which returns the device to the previously accessed 

screen.  

On most menus, frequently used options are programmed into two soft keys, allowing quick 

and easy access. The SHOUT nano can be turned off (completely off with no tracking and no 

text messaging) at any time by holding down the power/enter button for approximately two 

seconds. The device automatically “goes to sleep” after 90 seconds of inactivity. 

   WARNING! 
All batteries can cause property damage, injury, or burns if a conductive 
material, such as jewelry or keys, touches exposed terminals. The material 
may complete an electrical circuit and become extremely hot. To protect 
against such unwanted current drain, exercise care in handling any charged 
battery, particularly when placing it inside a pocket, purse, or other container 
with metal objects. 

Do not disassemble the SHOUT nano to replace the battery. Return it to NAL 
Research for services.  
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2.4 USING THE KEYBOARDS 
Some options require the use of on-screen keyboards to enter information. Three different 

keyboards are available. Figure 2 is an example of a keyboard to enter waypoint labels.  

• The up  key can be pressed repeatedly to switch between the keyboards.  

• The four arrow  buttons on the SHOUT nano are for navigating around 

the keyboards. 

• The enter  button is for selecting a highlighted character.  

• While entering text, the position of the cursor in the text box is shown as a thin, solid 

rectangular block.  

• The entered text can be edited by pressing the up arrow button until the cursor exits 

the keyboard into the text box and begins to blink.  

• The four arrow buttons can again be used to navigate and to place over a character to 

be corrected.  

• Pressing the enter button takes the user back to the keyboard and exits the text box.  

• The number displayed on the right corner of the LCD indicates the remaining allowable 

number of characters that can be entered into the text box. 

 
Figure 2: Keyboard to Enter Waypoint Labels 

Text Box 

Keyboard 

Done                                Clear 

                    Enter Text                  308 

Q E R W T Y U  I O P 
S D  A F G H  J K L 

Z X C V B N M  . 
Space @ .com 

Please send help 
Remaining  
number of 
allowable 
characters 
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2.5 NETWORK OPERATION CENTER (NOC) 
The SHOUT nano comprises a 9602 transceiver board capable of SBD connectivity to the Iridium 

satellite network. As a messaging and tracking device, its function is to send GPS reports and 

text messages to a Network Operation Center (NOC). It can be provisioned by NAL Research or 

any certified Iridium airtime service provider, including the DoD Defense Information Systems 

Agency (DISA) EMSS office, to send messages and reports to five different destinations (a 

combination of email addresses, Internet Protocol (IP) addresses, and other mobile devices). 

While in the field, the SHOUT nano can also accept real-time text messages and commands 

from a NOC. 

A NOC could be a sophisticated central monitoring center equipped with servers connected to 

high-speed networks. A NOC could also be as simple as a tablet, a laptop, or a desktop attached 

to the internet, to an Iridium transceiver, or to any wireless device. A NOC is required to receive 

and implement the logic necessary for analyzing the SHOUT nano messages and determine the 

appropriate response. 

2.6 SERVER FOR TRACKERS SOFTWARE 
Upon request, NAL Research provides the Server for Trackers software for users to install on 

their NOCs to retrieve NAL Research’s formatted GPS reports from the remote SHOUT nano. In 

addition, the program lets a NOC communicate with modems attached to its serial ports, Post 

Office Protocol (POP)3/ Simple Mail Transfer Protocol (SMTP) servers, Iridium SBD DirectIP 

servers, and/or act as a Router-based Unrestricted Digital Internetworking Connectivity 

Solution (RUDICS) server/client to support incoming and outgoing communications with the 

SHOUT nano. Under special cases, NAL Research releases our proprietary GPS report formats 

for developers to implement into their own tracking software. 

2.7 SATTERM SOFTWARE 
Along with the Server for Tracker software, SatTerm software is included for users to set up the 

SHOUT nano operating parameters, address book, and canned messages. Most of the operating 

parameters can be set using the SHOUT nano on-screen menus. However, more sophisticated 

features such as encryption must be carried out via SatTerm and a connected computer to the 
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SHOUT nano. For address book and canned messages, the SHOUT nano sends only short codes 

instead of the message body to a NOC server. Short codes are then mapped to the real 

addresses or canned messages with a lookup table saved on the NOC server during setup. 

Therefore, when the Satellite terminal emulator software (SatTerm) is used to enter address 

book and canned messages, SatTerm synchronizes short codes between the SHOUT nano and 

the NOC server. 

2.8 MAPPING NOC SERVER 
NAL Research also makes available a mapping NOC server to our customers only for 

demonstration purposes. Application developers can call to ask how to set up a free demo 

account. The server implements Google Earth to display the tracking information. NAL Research 

assumes no responsibility for any claims or damages arising out of the use of our server. NAL 

Research makes no warranties on the performance or the availability of our server. 
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3 HOME SCREEN 
Immediately after it’s powered up, the SHOUT nano momentarily displays the NAL Research 

logo followed by the home screen, as shown in Figure 3. Device status symbols are shown along 

the top of the home screen. Some symbols do not appear until an event is initiated, such as 

sending or receiving a message. 

 
Figure 3: Screens Displayed When Device is Powered Up 

3.1 STATUS SYMBOLS 

Table 1: Status Symbols 

 Denotes the Iridium transceiver is off. The Iridium transceiver is always kept off to 
preserve battery life until a message is required to be transmitted. 

 Denotes: (1) the Iridium transceiver is on with real-time signal strength represented 
by the number of vertical bars and (2) SBD message transmission is in progress. The 
signal strength can range from the lowest of zero to the highest of five bars. During 
transmission, the antenna must have a clear view of the sky. The SHOUT nano cannot 
send reports from inside a building. 

 Denotes the GPS receiver is off. The GPS receiver is always kept off to preserve 
battery life until time, date, or position information is needed. 

 Denotes the GPS receiver is on with real-time satellite acquisition status represented 
by the number of vertical bars. One bar represents valid time and date fix, two bars 
represent 2D fix or dead reckoning, three bars represent 3D fix with HDOP higher 
than 2.0, and four bars represent 3D fix with HDOP less than 2.0. Although the 
SHOUT nano GPS receiver can often obtain a location fix when the antenna is 
partially blocked (near buildings, in a room next to a window, etc.), the antenna must 
have a clear view of the sky to minimize acquisition time and attain better position 
accuracy. 

                  NAL Research Corp 
                  © Copyrighted 2010 

Check-In               Way Point 

Last Report 
Date: 20-Jul-10 
Time: 08:00AM 
Lat: 38:45:8.7 N 
Long: -77:28:58.3 W 
 

20-Jul-10                         08:00 AM 
GPS ---- 
Iridium ----- 

(10 min) 

Messaging 
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Table 1: Status Symbols 

 Denotes tracking mode is off when the tracking symbol is dimmed blue. 

 Denotes tracking mode is on when the tracking symbol is bright white. Next to the 
tracking symbol is the countdown timer to the next report. 

 Denotes all the audio alerts are off. 

 Denotes the audio alert is on. 

 Denotes one or more unread messages are in the Inbox. 

 Denotes one or more messages are in the Outbox ready to be sent, or one or more 
messages in queue failed to send. 

 The battery indicator with five bars denotes it’s fully charged. 

3.2 DATE/TIME 
The current time and date are displayed with the formats defined using the Settings > Time and 

Date menu. The GPS receiver has an internal clock, and as long as the battery is not depleted 

and a valid position fix was previously acquired, the SHOUT nano can recall the correct date and 

time. The message “Date/Time unavailable” is displayed when the SHOUT nano is unable to 

restore information from the GPS receiver. 

3.3 HOME ICONS 
Immediately below the date and time, the SHOUT nano displays four main icons, each 

representing a menu option—Messaging, Tracking, Utilities, and Settings (see Figure 4). 

Detailed descriptions of each of these menu options are included in the next sections. Use the 

arrow  buttons to place the cursor over an icon. The perimeter of an icon lights up and a 

label appears underneath it when the cursor is placed over it. Use the enter  button to 

select the menu option. 
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Figure 4: Home Icons 

3.4 LAST REPORT 
The last successful report sent by tracking or emergency notification is displayed in the text box 

below the Home icons (see Figure 5). Check-In, Way Point, free-text, and canned messages are 

not considered “reports,” and therefore are not displayed on the home screen even if a 

message was sent successfully. With limited space on the LCD screen, only date, time, latitude, 

longitude, and altitude are visible in dimmed gray text. Additional information can be seen by 

pressing the arrow down button. After the arrow button is pressed, the text changes from gray 

to bright white for better readability. Displayed text can be changed back to gray by repeatedly 

pressing the left arrow  button. The Last Report information is saved on the SHOUT nano’s 

nonvolatile memory. Even if battery power is removed, the information can still be restored. All 

displayed GPS parameters are self-explanatory except Vvel, which stands for Vertical Velocity. 

 
Figure 5: Last Report Information 

Check-In               Way Point 
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Date: 20-Jul-10 
Time: 08:00AM 
Lat: 38:45:8.7 N 
Long: -77:28:58.3 W 
 

20-Jul-10                         08:00 AM 
GPS ---- 
Iridium ----- 

(10 min) 

Messaging 

   Home Icons 

Check-In               Way Point 

Last Report 
Date: 20-Jul-10 
Time: 08:00AM 
Lat: 38:45:8.7 N 
Long: -77:28:58.3 W 
 

20-Jul-10                         08:00 AM 
GPS ---- 
Iridium ----- 

(10 min) 

Messaging 

Last Report information lights 

up when the            or              

button is pressed. 
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3.5 CHECK-IN (SOFT KEY) 
The Check-In soft key (see Figure 5) allows sending a quick message with a single, easily 

accessed button. When the Check-In button is pressed from the home screen, a second screen 

appears requesting confirmation. Once confirmed, the SHOUT nano sends out a short code 

representing a Check-In message. If the Settings > Include GPS option is enabled, the GPS 

location will be attached to the Check-In message. Check-In messages with GPS location take 

longer to complete because the SHOUT nano has to acquire a GPS fix first. Depending on the 

validity of the stored ephemeris data or the Accuracy setting, it could take an additional 29 

seconds. The Check-In message uses the same canned message’s short code format. 

3.6 WAY POINT (SOFT KEY) 
A waypoint is a GPS location that you can identify and mark with a specific name tag for future 

reference.  

1. Press the Way Point soft key from the home screen (see Figure 5). The SHOUT nano 

immediately turns the GPS receiver on to acquire a fix.  

2. Select one of the following options. 

a. Go back to the home screen without further action. 

b. Reacquire a new GPS fix. 

c. Save the waypoint.  

i. Select Next to open a full keyboard in order to enter the waypoint label.  

Note: Use the  key to toggle between the keyboards. 

A waypoint label can have up to 309 characters. As each character is entered, the remaining 

allowable number of characters for the label is displayed at the top of the LCD. The Add option 

saves the waypoint into the SHOUT nano’s nonvolatile memory for later retrieval. The SHOUT 

nano can store up to 1,000 waypoints. The oldest point is overwritten as the memory becomes 

full. After saving a waypoint, you can also send it to a NOC server. The server differentiates a 

Way Point report from a normal tracking report by their short codes. 
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4 QUICK START 
Before use, airtime must first be purchased from NAL Research or from any of Iridium certified 

airtime resellers. The SHOUT nano’s International Mobile Equipment Identification (IMEI) 

number must be registered by an airtime reseller to “point” to a NOC server. To learn how to 

operate the SHOUT nano as a messaging device, read the entire user guide. However, as a 

tracking device, you can quickly set up the SHOUT nano with just three simple steps: 

1. Turn the SHOUT nano on by holding down the Power/Enter button  for about two 

seconds. 

2. Go to the Report Rate menu to set the reporting frequency.  

3. Go to the Track On/Off menu  to enable tracking. The SHOUT nano is now in 

tracking mode and is ready to send position reports at the rate chosen in step 2. No 

further action is required. The unit automatically goes to “sleep” in between reports. 

IMPORTANT: NAL Research can enable the SHOUT nano for use on the DoD EMSS Gateway. 

However, accessing the EMSS Gateway is not authorized until the SHOUT nano is provisioned 

(signed up for airtime). Unauthorized attempts to access the EMSS Gateway will result in 

immediate disabling of the offending device, which must then be returned to NAL Research for 

repair. Please see webpage https://emss.pac.disa.mil/home.shtml for more information 

regarding DoD EMSS service provisioning. 

https://emss.pac.disa.mil/home.shtml


This document contains NAL Research proprietary information which may not be 
used, reproduced, or disclosed without written approval from NAL Research 

 SHOUT nano User Guide Version B 

Document Number: 451-92681-001B 26 of 61 

5 MESSAGING MENU 
Use the Messaging menu to compose, save, view, and send canned or free-text 

messages. There are six options under the Messaging menu, including Address Book, 

Compose, Inbox, Drafts, Outbox, Sent, and a Check Mailbox soft key (see Figure 6). 

 
Figure 6: Messaging Menu 

5.1 ADDRESS BOOK 
The Address Book lists contacts created and saved into the SHOUT nano’s memory using 

NAL Research’s SatTerm software. During setup, SatTerm requires connectivity between 

the SHOUT nano and a NOC server to synchronize the lookup table of short codes. As with 

canned messages, short codes are used to map real addresses to a lookup table located at a 

NOC. 

The SHOUT nano can save 1,200 contacts in memory with a maximum contact name of 30 

characters long. Each contact has its data stored in a three-line format. The first line can have 

up to 30 characters, the second can have 50 characters, and the third can have 30 characters. 

The information contained in each line is defined by developers. 

Figure 7 displays an example of the formatted Address Book contact defined by the NAL 

Research’s NOC server. The first line has the contact phone number, the second line has the 

email address, and the third line has the home address. Upon receiving a free-text or canned 

message from the SHOUT nano referenced to a specific Address Book contact, the NAL 

Research’s NOC server forwards the message to the email address listed on the second line of 

Check Mailbox 

Address Book 

Messaging 
GPS ---- 
Iridium ----- 
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the Address Book contact. Application developers can define their own set of rules with 

information contained in the Address Book contact so that their NOC servers can use them to 

determine the appropriate response. 

 
Figure 7: Address Book Contact 

5.2 COMPOSE 
Use the Compose menu to edit and send canned messages, free-text messages, or a 

combination of canned and free-text messages to a NOC server. Three on-screen 

keyboards are available for information to be entered or modified. The up  key can be 

pressed repeatedly to switch between the keyboards. When Compose is selected, the Message 

menu appears with three options—Choose Canned Msg, Enter Text, and Next. 

5.2.1 CHOOSE CANNED MSG 
The Choose Canned Msg option lists canned messages you can select to send to a NOC. Sending 

canned messages saves bandwidth and airtime cost because it is only short codes that are 

being transmitted instead of the entire message body. SatTerm is used to create and save 

canned messages into the SHOUT nano’s memory. During setup SatTerm requires connectivity 

between the SHOUT nano and a NOC server to synchronize the lookup table of short codes. As 

with the Address Book, short codes are used to map the actual canned messages to a lookup 

table located at a NOC. The short codes are defined by application developers and not by the 

SHOUT nano. 

Page Up              Page Down 

Address Book 

Gene 
Jesse 
Sherrel 
Peter 
Stephanie 
 

 

Gene 

703-392-1136 
gp@nalresearch.com 
9300 Courthouse Road 
Manassas, VA 20110 
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Figure 8: Canned Message Examples 

The SHOUT nano can store up to 600 canned messages. Figure 8 displays examples of a few 

canned messages entered using SatTerm. Each message is shown on a single line. Some canned 

messages are too long and can only be partially displayed on the LCD screen. Navigate by 

pressing the up and down arrow  buttons and by pressing the enter  button to show 

the entire message on the Details screen. 

When a canned message is selected from the list, for example, ‘Out of gas!!! Please send,’ as 

shown in Figure 9, the Details screen appears to show the complete message. Select a canned 

message by pressing the enter  button or press the BACK  button to go back to the 

original list of canned messages. If the enter button is pressed, the Message menu reappears 

with the selected canned message displayed in the text box. Use the Scroll Up and Scroll Dn soft 

keys to view part of the canned message that does not fit inside the text box. Remove Canned 

Msg deletes the message from the text box at any time even after free-text is entered. 

Scroll Up                 Scroll Dn 

Message 

Choose Canned Msg 
Enter Text 
Next 
 Page Up              Page Down 

Canned Messages 

I am here. 
Out of gas!!! Please send 
On my way home. 
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Figure 9: Canned Message Selected 

5.2.2 ENTER TEXT 
Use the Enter Text option to create free-text messages with three on-screen keyboards. Each 

free-text message is allowed to have up to 309 characters (the Iridium 9602 limits outbound 

messages to 340 characters). These 309 characters are shared between a free-text message and 

any additional email addresses attached to it (including the semicolon or space used as an email 

address separator). Long email addresses or multiple email addresses reduce the number of 

characters available for the free-text message (see detailed description in the next section, 

Send Message). If a canned message is previously selected and appears in the text box, then 

the entered free-text is appended to the canned message. 

 
Figure 10: Enter Text 

Select 

Details 

Out of gas!!!  Please send 
help immediately. 

Scroll Up                 Scroll Dn 

Message 

Remove Canned Msg 
Enter Text 
Next 
 

Out of gas!!!  Please send 
help immediately. 
 

Scroll Up                 Scroll Dn 

Message 

Please send 
 

Remove Canned Msg 
Enter Text 
Next 
 Done                               Clear 

                 Enter Text          286 

an extra pair of gloves 
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5.2.3 SEND MESSAGE 
After composing a message, select Next to send the message to a NOC server. A contact 

selected from the Address Book and email addresses to whom the message is destined must be 

entered through the Choose Contact and Enter Emails options. Choose Contact opens the 

Address Book screen. Enter Emails opens on-screen keyboards to enter email addresses 

separated by a semicolon. The total number of characters of all email addresses including the 

semicolons must be less than the difference between 309 and the number of characters in the 

free-text message. The SHOUT nano keeps track of the limit and prevents entering email 

addresses longer than allowed. 

 
Figure 11: Send Message or Save as Draft 

Once all required information is entered, either Send the message or Save as Draft. If Send is 

selected, a Success screen appears to indicate that the message has been added to the Outbox. 

The SHOUT nano must be held with the antennas having full view of the sky. If the Settings > 

Include GPS option is turned on, then GPS location is added to the message. Messages with GPS 

location take longer to complete because the SHOUT nano has to acquire a GPS fix. 

5.3 INBOX 
The Inbox folder contains all incoming read and unread messages with the newest 

message at the top of the list.  

• Read messages have a white opened envelope  icon next to them.  

• Unread messages have a green closed envelope  icon next to them.  

• The arrow buttons are used to place the cursor over a message. 

Scroll Up                 Scroll Dn 

Send To 

Remove Contact 
Enter Emails 
Next 
 

To: Gene 
Emails: jp@nal.com; 
sb@nal.com; pk@nal.com 

Scroll Up                 Scroll Dn 

Options 

 
Send 
Save as Draft 
 

To: Gene 
Emails: jp@nal.com; 
sb@nal.com; pk@nal.com 

Please bring 
an extra pair of gloves 
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• The enter button is used to read a highlighted message.  

• The message icon  appears at the top of the home screen when one or more unread 

messages are in the Inbox.  

• The speaker provides an audible alert for all new incoming messages.  

• The SHOUT nano can store up to 690 messages in the Inbox. 

5.4 DRAFTS 
The Drafts folder contains draft messages saved under the Compose menu. The SHOUT 

nano can store approximately 190 draft messages with the newest message displayed at 

the top and the oldest message displayed at the bottom of the list.  

• The arrow up/down buttons place the cursor over a draft message.  

• The enter button recalls and displays the highlighted message content.  

• Options > Edit returns to the Compose menu for editing. 

• Options > Delete removes the message from the Drafts folder.  

• If Send is selected, a Success screen appears to indicate that the message has been 

added to the Outbox. The SHOUT nano must then be held in a position with the 

antennas having full view of the sky.  

o If the Settings > Include GPS option is turned on, then GPS location is attached to 

the message. Messages with GPS location can take longer to complete because the 

SHOUT nano has to acquire a GPS position. 

5.5 OUTBOX 
The Outbox folder contains either messages in the queue ready to be sent or messages 

that failed to send.  

• A message in the process of being sent has a << symbol next to it.  

• A message failed to send has an X symbol.  

• A message in queue waiting to be sent has no symbol.  

Once a message has failed to send, it can stay in the Outbox until you decide to either resend 

(Enqueue) or delete. The Outbox can store approximately 170 messages with the oldest 

message at the top of the list. 



This document contains NAL Research proprietary information which may not be 
used, reproduced, or disclosed without written approval from NAL Research 

 SHOUT nano User Guide Version B 

Document Number: 451-92681-001B 32 of 61 

 
Figure 12: Outbox 

For each message queued in the Outbox, the SHOUT nano attempts to transmit up to three 

times. After three failures, the message is dequeued to avoid draining the battery. You have to 

manually requeue a message. If the SHOUT nano is at a location not suited for transmission, 

monitor the Outbox and repeatedly requeue until the message is successfully transmitted. The 

 symbol appears at the top of the home screen when there is a queued or dequeued 

message(s) in the Outbox. 

Note: The SHOUT nano will NOT resend “failed messages” even after the Iridium signal 

becomes available. You have to manually requeue one or more failed messages in order to 

resend. This is to prevent unintentional depletion of battery power in case there is a large 

number of failed messages in the Outbox. A failed Cancel 911 message also needs to be 

requeue. 

5.6 SENT 
The Sent folder contains messages successfully sent to a NOC server. When the enter 

button is pressed on a highlighted message, detailed information about the message 

appears.  

• The Delete soft key deletes the message. 

• Select the Options soft key to resend, forward, or delete the message.  

o Resend puts the message back at the bottom of the Outbox folder’s sending queue.  

o Forward opens the Compose menu for additional information to be entered. Either 

resend the message after modifying it or cancel the process.  

Page Up              Page Down 

Outbox 

x Check-In 
x Out of gas 
<< Position Report 
On my way home 
 

Failed to send 

Sending 
Waiting to be sent 
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o Delete permanently removes the message from the Sent folder (same as the Delete 

soft key in the header menu). 

The SHOUT nano can store approximately 580 messages in the Sent folder with the newest 

message displayed at the top of the list. 

5.7 CHECK MAILBOX (SOFT KEY) 
There are four ways the SHOUT nano initiates a mailbox check for any pending messages at the 

Iridium gateway: 

• Manually force the SHOUT nano to check the mailbox at any time by pressing the Check 

Mailbox soft key (see Figure 6) under the Messaging menu. 

• Manually force the SHOUT nano to check the mailbox at any time using the Utilities > 

Check Mailbox menu. 

• When tracking mode is enabled, the SHOUT nano automatically checks the mailbox 

each time it wakes up to send a position report. 

• When tracking mode is enabled and in addition to checking the mailbox each time it 

wakes up to send a report, the SHOUT nano also automatically wakes up and checks 

the mailbox at a preset mailbox check rate. Set the mailbox check rate using the Report 

Rate menu option. A position report will not be sent when the SHOUT nano wakes up 

to check the mailbox unless the mailbox check rate coincides with the tracking report 

rate. 

The Check Mailbox menu can either be Idle or Checking the Iridium gateway for any pending 

messages to be downloaded. As the messages are being downloaded, the SHOUT nano shows 

the number of Unread messages in the Inbox and the number of messages still Queued at the 

Iridium gateway to be downloaded. 
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Figure 13: Check Mailbox 
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6 TRACKING MENU 
Use the Tracking menu (see Figure 14) to enable the SHOUT nano tracking mode, disable 

the tracking mode, set the reporting rate, set the mailbox check rate, cancel the 

emergency 911 signal, view the unit reporting data, set GPS location accuracy, and set the 

position report format. 

 
Figure 14: Tracking Menu 

6.1 TRACKING ON/OFF 
Use the Tracking On/Off option to set the SHOUT nano tracking mode. When Enable 

Tracking is selected, the tracking symbol  changes from dimmed blue to bright white (see 

Figure 15). The SHOUT nano immediately turns the GPS receiver on to acquire a GPS fix and 

then attempts to transmit a position report. The next position report is sent automatically 

based on the reporting rate set under the Report Rate option. A countdown timer to the next 

report is displayed inside the parentheses next to the tracking symbol (see Figure 15). When 

tracking is enabled and the SHOUT nano sleeps in between reports, the status LED  flashes 

once every five seconds. It can be turned off during sleep to reduce power consumption by 

using the Settings > LED option. The emergency 911 button can be activated at any time during 

tracking mode or non-tracking mode. The SHOUT nano can also be powered up at any time and 

be used as a messaging device. 

When waking up to transmit a location report, the SHOUT nano antennas must have full view of 

the sky; it will otherwise fail to send. A missed report will not be resent. The entire reporting 

 

Tracking On/Off 

Tracking 
GPS ---- 
Iridium ----- 
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duration can take up to two minutes depending on the Iridium satellite visibility and the validity 

of the GPS ephemeris data. Ephemeris data saved on the GPS receiver is valid for approximately 

two hours, allowing the receiver to obtain a hot-start fix. Report rate (time between reports) 

set to more than two hours forces the GPS receiver into either a warm-start or cold-start fix 

(approximately 29 seconds). As a result, the SHOUT nano will consume more battery power and 

the total number of reports is significantly reduced. Read Appendix C: Power Consumption for 

more information. 

 
Figure 15: Tracking On 

Note: When the SHOUT nano is in the middle of sending a report and a user forces it to power 

off by holding down the power  button, the SHOUT nano attempts to complete sending the 

report before shutting down. A warning message appears on the LCD screen and remains until 

either a position report is sent or fails to send. Go back to the home screen by pressing the 

BACK button. 

The SHOUT nano logs and saves all position reports in its circular memory. When its memory is 

full, the oldest reports are overwritten. SatTerm can be used to retrieve all position reports 

saved on the SHOUT nano. 

6.2 REPORT RATE 
Use the Report Rate option to set the report frequency (time between reports) when 

Tracking On/Off is enabled. Once a report rate is selected, a new menu appears 

requesting the mailbox check rate. The mailbox check rate can be the same as the report rate. 
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In this case, the SHOUT nano checks the mailbox each time it wakes up to send a report. If the 

mailbox check rate is different than the report rate, the SHOUT nano wakes up in between 

reports to check the mailbox without sending a position report. The SHOUT nano only offers 

the mailbox check rates that are evenly divisible to the report rate. 

IMPORTANT: The total number of reports the SHOUT nano can send with a fully charged 

battery depends on three settings—the report rate, the mailbox check rate, and the accuracy. 

Read Appendix C: Power Consumption for details on how these settings can affect the SHOUT 

nano performance. 

6.3 CANCEL 911 

After pressing the red emergency  button on the back of the SHOUT nano (see Figure 

1), you can deactivate the emergency alert by selecting the Cancel 911 option. A screen 

appears with two options: (i) With Gateway Ack or (ii) Without Gateway Ack. 

When With Gateway Ack is selected and confirmed, the cancellation message is queued in the 

Outbox to be transmitted. If the cancellation message is successfully transmitted and 

acknowledged by the Iridium gateway, the emergency mode ends, the emergency LED  is 

turned off, and the top and bottom bars turn from red to blue. Powering the SHOUT nano off 

does not cancel the emergency mode. You MUST select Cancel 911 to cancel the emergency. 

When Without Gateway Ack is selected and confirmed, the cancellation message is queued in 

the Outbox to be transmitted. The emergency mode ends immediately, the emergency LED  is 

turned off, and the top and bottom bars turn from red to blue. 

6.4 STATS 
When Tracking On/Off is enabled, the SHOUT nano monitors useful statistics, which are 

displayed under the Stats screen. Data are cumulative over all tracking cycles.  

• Manually reset displayed data at any time using the Clear Stats soft key.  

• A countdown timer to the next report is shown beside Time to Next and is replaced 

with Off when Tracking On/Off is disabled.  

• The number of Successes represents the total number of position reports successfully 

transmitted to the Iridium network both with valid and invalid position fix.  
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o The number inside the parentheses next to Successes represents the number of 

position reports successfully transmitted but with invalid GPS fix.  

• The number of Fails represents the total number of valid position reports that failed to 

send to the Iridium network. 

 
Figure 16: Stats 

6.5 ACCURACY 
Use the Accuracy option to select either Standard or Best accuracy when acquiring a 3D 

GPS fix. For Standard setting, the SHOUT nano acquires 3D fix using saved ephemeris data 

in its nonvolatile memory. The ephemeris is updated only when it becomes invalid. For Best 

setting, the SHOUT nano always updates the ephemeris data first before attempting to obtain a 

3D fix. The Best setting takes longer for a 3D fix. However, the probability of obtaining position 

accuracy to within 2.5 meters is much higher than for the Standard setting. Best setting is not 

recommended when operated in environments with limited view of the sky, such as under 

heavy foliage. Choosing Best accuracy setting can significantly reduce the total number of 

reports on a fully charged battery due to longer GPS acquisition time. Choosing Best accuracy is 

the same as setting the report rate to more than two hours. For both cases, the SHOUT nano 

has to update the ephemeris data. Refer to Appendix C: Power Consumption. 

6.6 FORMAT 
The SHOUT nano can transmit position reports in either 30-byte or 10-byte format. The 

30-byte format includes Coordinated Universal Time (UTC) date, UTC time, latitude, 

longitude, altitude, speed, course, vertical velocity, number of satellites used to obtain 3D fix, 
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Horizontal Dilution of Precision (HDOP), and Vertical dilution of precision (VDOP). The latitude 

and longitude are recorded with approximately 0.18 meters’ resolution. 

The 10-byte format includes UTC time, latitude, longitude, and Position (3D) Dilution of 

Precision (PDOP). With UTC date omitted, the SHOUT nano relies on the NOC server to record 

the date. Encryption cannot be used with the 10-byte format. Latitude and longitude are 

recorded with approximately 1.1 meters’ resolution. Even though the message length is 

shorter, a 10-byte format message consumes the same amount of power to transmit as a 30-

byte format. It is to be selected strictly for the purpose of airtime cost-saving. 
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7 UTILITIES MENU 
The Utilities menu provides six options used mainly to check for proper hardware and 

network setup, as shown in Figure 17. These include Check GPS, Check Iridium, send Test 

Report, Check Mailbox, Check-In, and Way Points. 

 
Figure 17: Utilities Menu 

7.1 CHECK GPS 
The Check GPS option forces the SHOUT nano to turn on its GPS receiver and to 

continuously update and display GPS data in real-time whether there is a valid fix or not. 

The GPS receiver remains on until you leave this screen by pressing the BACK button. Use the 

Reset Ephemeris soft key (see Figure 18) to force the SHOUT nano to erase saved ephemeris in 

its memory and download a new set of ephemeris data. Be careful not to deplete the battery 

power by staying on this option for too long. 

 

Utilities 
GPS ---- 
Iridium ----- 

Check GPS 
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Figure 18: Reset Ephemeris Key 

The accuracy of the position can be monitored by observing the (Horizontal Accuracy) HACC. 

The HACC is measured in meters. HACC is defined as the radius of a circle centered on the true 

value that contains the GPS measurement. Thus, a position fix with ten meters’ HACC accuracy 

indicates that it is within ten meters of the true position—the higher the HACC value, the less 

accurate the GPS measurement. 

The Check GPS option is a good indicator of whether or not to initiate a Way Point or a Test 

Report when located in a challenging environment, e.g., in dense foliage or around urban 

settings with tall buildings. HACC can be monitored in real-time to make sure it converges to a 

small and stable value (usually less than 30 meters). At that point, it is certain that a 3D fix can 

be obtained with the most current ephemeris data being updated and saved. You can then go 

back to the Utilities menu to send a test report. When the GPS receiver cannot acquire a fix, 

HACC gradually increases and stops at a value of 4294967.500. This indicates that the 

surrounding obstructions prevent the GPS receiver from obtaining a fix and you should move on 

to a different location. 

7.2 CHECK IRIDIUM 
The Check Iridium option forces the SHOUT nano to turn on its Iridium transceiver and 

continuously update and display signal strength information in real-time. The Iridium 

transceiver remains on until you leave this screen by pressing the BACK button. Be careful not 

to deplete the battery power by staying on this option for too long. 
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7.3 TEST REPORT 
When the Test Report option is selected, the SHOUT nano immediately turns the GPS 

receiver on to refresh its location data. The location information is continuously updated 

and displayed in real-time whether there is a valid fix or not. Similar to the Check GPS option, 

HACC can be monitored to see if a valid fix is possible. Once a valid fix is obtained, the GPS 

receiver is turned off and the most recent 3D fix information is displayed on the screen. This 

information, called test report, can be forced to send to a NOC server by pressing the Send soft 

key. A test report has the same format as a regular position report and is treated as such by a 

NOC. Sending a test report does not disrupt or change the tracking reporting rate. 

The Test Report option is a good diagnostic tool used to ensure proper operation of the GPS 

receiver and the Iridium transceiver. It can also be used to manage battery life by turning off 

tracking mode and strategically sending on-demand location reports. It can be considered as 

“manual tracking mode.” 

7.4 CHECK MAILBOX 
A detailed description of this option can be found in section 5.7 Check Mailbox (Soft 

Key)on page 33. 

7.5 CHECK-IN 
A detailed description of this option can be found in section 3.5 Check-In (Soft Key)on 

page 24. 

7.6 WAY POINTS 
The Way Points menu is used to acquire, view, save, delete, and send a waypoint to a 

NOC. Choosing the New option is the same as pressing the Way Point soft key on the 

home screen (see section 3.6 Way Point (Soft Key)on page 24 for a detailed description). A list 

of saved waypoints can be displayed and viewed by selecting the List option. After selecting the 

List option, any saved waypoint label can be edited, sent/resent, or erased. The SHOUT nano 

can save up to 1,000 way points in its circular memory. SatTerm can be used to retrieve 

waypoints saved on the SHOUT nano. 
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7.7 SECURITY 
Use the Security menu to set the menu lock Personal Identification Number (PIN).  
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8 SETTINGS MENU 
Use the Settings menu to view and configure the SHOUT nano hardware settings. There 

are twelve options available (see Figure 19). 

 
Figure 19: Settings Menu 

8.1 AUDIO 
Use the Audio option to change the alert frequency and tone, mute incoming message 

alerts, and mute all audio feedback. The  icon appears on the home screen if Mute All 

is on. You can test the audio volume and sound before selecting by using the Preview soft key. 

8.2 CONTRAST 
Use the Contrast option to change the LCD contrast by pressing the arrow up and down 

buttons. Press the enter button to select the setting and press the BACK button to go 

back to the Settings menu without change. 

8.3 BACKLIGHT 
Use the Backlight option to set the period of inactivity after which time the SHOUT nano 

turns the LCD backlight off. The SHOUT nano consumes approximately 40 mA less with 

the LCD backlight set to Always Off. Setting the backlight to Always On is recommended for 

nighttime use. 

 

Settings 
GPS ---- 
Iridium ----- 

   Audio 
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8.4 LED 

The SHOUT nano has a single status LED  at the top-left corner to alert you whether the 

device is in tracking mode or emergency mode. The LED flashes once every five seconds when 

Tracking On/Off is enabled and the device sleeps (in between tracking reports). The LED turns 

solid green when emergency mode is enabled regardless of whether the device is on or off. The 

LED can be turned off for either of these two cases to save battery power using the LED option. 

The SHOUT nano consumes approximately 3 mA less with the LED disabled during emergency 

and 125 μA less with LED disabled during tracking mode. 

8.5 INCLUDE GPS 
The Include GPS option forces the SHOUT nano to attach GPS location to Check-In, 

canned, and free-text messages. Under the default setting, these messages do not have 

GPS information included. Messages with GPS location included can take longer to complete 

because the SHOUT nano has to acquire a GPS fix first. Depending on the validity of the stored 

ephemeris data or the Accuracy setting, it could take an additional 29 seconds. 

8.6 GPS 
The GPS option gives access to the Position Format and Position Model settings.  

Use the Position Format option to select one of three different GPS position formats to be 

displayed on the LCD screen. Do not confuse this option with the Format option under Tracking, 

which defines the format of a position report to be transmitted to a NOC.  

The Position Model option allows the GPS receiver to be more accurate by telling the unit what 

its environment is like. For applications operating below 12 km, the Portable setting is 

sufficient. If operation above 12 km is required, refer to the “AT Commands for SHOUT nano” 

[1] document for details. 

8.7 TIME AND DATE 
Use the Time and Date option to select UTC time and date formats to be displayed on the 

LCD screen for all menus. The local time zone can also be set. 
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8.8 SOFT KEYS 
When tracking mode is enabled and the SHOUT nano is off (sleeps between reports), 

either Check-In or Way Point can be activated by pressing one of these two soft keys 

without first pressing the power on button. This feature can be disabled by using the Soft Keys 

option to prevent accidental power up, thus forcing you to first turn the SHOUT nano on by 

pressing the power button before activating the Check-In or Way Point soft key. 

8.9 USER INFO 
The User Info option displays user information entered using SatTerm software. 

8.10 UNIT INFO 
The Unit Info option displays the internal 9602 module’s IMEI number, Iridium FCC ID, 

Iridium IC ID, and the SHOUT nano’s firmware version. 

8.11 MEMORY 
Use the Memory option to clear messages in all mail boxes or clear messages in each 

individual mail box—Drafts, Inbox, Outbox, and Sent. 

8.12 RESET 
The Reset option restores all setup parameters back to the manufacturer’s settings. When 

Reset is selected, a screen appears with the current settings and asks for confirmation to 

reset the current settings back to the manufacturer’s default settings.   
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9 ADDITIONAL FEATURES 
9.1 EMERGENCY (911) BUTTON 

The red emergency 911 button  is located underneath a rotating guard on the back of the 

SHOUT nano (see Figure 1, callout 6). It can be used at any time regardless of the tracking 

status (enabled or disabled) or the device’s power status (on or off). When pressed, the 

emergency LED  immediately turns solid green to indicate that the device is in emergency 

mode. The LED can be deactivated to extend the battery life by using the Settings > LED > 

Power LED emergency option. If the LCD screen is on during emergency activation, the blue 

bars across the top and bottom of the screen turn red. The device sends three consecutive 

reports to a NOC as quickly as possible. After sending the first three emergency reports, the 

SHOUT nano reverts back to the default emergency Time-Between-Reports (TBR) of two 

minutes. During emergency a NOC can send an acknowledgement back to the SHOUT nano. 

 
Figure 20: Emergency (911) Button Feature 

9.2 STATUS LED 
There is one status LED on the top-left of the SHOUT nano (see Figure 1). The LED turns solid 

green when the SHOUT nano is in emergency mode, which can be deactivated to save power 

using the Settings > LED > Power LED Emergency option. It flashes once every five seconds 

when the SHOUT nano is off and tracking is enabled. It can be deactivated to save power using 

Settings > LED > Power LED Tracking option. 

 

Tracking On/Off 

(<1 min) 
Tracking 

GPS ---- 
Iridium ----- 

These two bars turn 
from blue to red 
under emergency 
mode. They both turn 
back to blue when 
the device is taken 
out of emergency 
mode. 

The status LED turns 
solid green under 
emergency mode. 
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9.3 POWERING DOWN 

The SHOUT nano can be powered down by holding the power  button (see Figure 1) for 

approximately two seconds. A power-down screen appears with a message indicating tracking 

and messaging will be completely turned off. The screen stays on for approximately ten 

seconds before shutting down. Press the Turn Off soft key on the left to turn off the SHOUT 

nano immediately or Cancel shutdown by pressing the right soft key. 

 
Figure 21: Power Down Screen 

Turn Off                      Cancel 

 

Powering down… 
 
Device will not track or 
receive messages. 
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APPENDIX A: PMS FEATURES 
A.1 TRACKING 

The SHOUT nano is capable of sending position reports in PECOS Message Structure 

(PMS). The PMS complies with the Blue Force Tracking Data Format Specification as 

defined in the document PECOS 200708-001 Version 1.3 [2]. The SHOUT nano is shipped 

without PMS features activated and can only be enabled by NAL Research at the request of an 

authorized user. When PMS is enabled, the Format menu has an additional option called 

PECOS, as shown in Figure 22. 

 
Figure 22: Format Menu 

A.2 BREVITY CODE 
With PMS enabled, you can select any one of sixteen Brevity Codes (0000 through 1111) 

to be included in the tracking reports. There are two ways to set the Brevity Code:  

1. Under the Tracking > Brevity Code menu, the  and  soft keys can be pressed 

repeatedly to browse through the list of codes. The code appearing on the screen will 

be automatically used by the SHOUT nano to include in the tracking reports. No further 

action is needed to select the brevity code. 

 

Format 

O Full, 30 bytes 
O Position Only, 10 bytes 
O PECOS 
 
 

 

 

Tracking 
GPS ---- 
Iridium ----- 

     Format 
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Figure 23: Brevity Code 

2. When the PECOS format is selected using the Tracking > Format menu, the default 

Brevity Code setting appears at the bottom of the home screen, replacing Check-In and 

Way Point. The  and  soft keys can be pressed repeatedly to browse through the list 

of Brevity Codes. The code appearing on the screen will be automatically used by the 

SHOUT nano to include in the tracking reports. No further action is needed to select the 

brevity code. 

A.3 SOFT KEYS 
When the PECOS format is enabled using the Tracking > Format menu, the Check-In and 

Way Point features are replaced with the Brevity Code at the bottom of the home screen. 

You can override the Brevity Code soft keys and revert back to the Check-In and Way Point soft 

keys by going to the Settings > Soft Keys > PECOS menu to turn off the PECOS soft keys (see 

Figure 24). After turning off the PECOS soft keys, the Brevity Code setting can only be 

configured through the Tracking > Brevity Code menu. 

 

Brevity Code 

    O A    O B    O C    O D 
 

 

 

Tracking 
GPS ---- 
Iridium ----- 

     Format 
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Figure 24: Soft Keys 

A.4 CANCEL 911 WITH SOFT KEYS 
When the PECOS format is enabled and after the emergency button is pressed, the soft keys on 

the home screen are replaced with “X Emr w/” and “X Emr w/o”, as shown in Figure 25. As an 

alternative to using the Cancel 911 menu, these two soft keys can also be used to deactivate 

the emergency alert. Pressing the “X Emr w/” soft key is the same as selecting With Gateway 

Ack under the Cancel 911 menu. Pressing the “X Emr w/o” soft key is the same as selecting 

Without Gateway Ack under the Cancel 911 menu. 

 
Figure 25: Cancel 911 with Soft Keys 

 

Soft Keys 

   Check-In 
   Way Point 
   PECOS 
   

X Emr w/              X Emr w/o 

Last Report 
Date: 20-Jul-10 
Time: 08:00AM 
Lat: 38:45:8.7 N 
Long: -77:28:58.3 W 
 

20-Jul-10                         08:00 AM 
GPS ---- 
Iridium ----- 

(10 min) 

Messaging 
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APPENDIX B: UPGRADING THE FIRMWARE 
The SHOUT nano firmware can be upgraded using a PC connected to the USB port of the device. 

The device drivers support Windows XP, Windows Vista, and Windows 7. 

1. Run the NAL USB Bootloader program. 

 

Figure 26: NAL USB Bootloader 

2. With a USB cable attached to a computer and the device, select the Start Flash Mode 

button. 

3. Wait until it activates and then select Open Hex File. 

4. Browse and select a valid NAL device BIN file. NAL Research makes the BIN file available 

upon request. 

5. Once the BIN file is loaded, select Program/Verify. 

6. Wait for the programming to complete. 

7. Select Reset Device. The new firmware is now loaded on the device. 
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APPENDIX C: POWER CONSUMPTION 
The SHOUT nano has an internal 1.95 Ah Lithium-ion (Li-ion) rechargeable battery. When both 

the Iridium and GPS antennas have clear view of the sky and the battery is fully charged, the 

SHOUT nano is capable of sending more than 1,500 tracking reports with the following settings: 

(1) report rate of less than two hours, (2) mailbox check rate and the report rate are the same 

and (3) Standard Accuracy. Blocked or partially blocked antennas will force the SHOUT nano to 

retry multiple SBD transmissions for each report, and as a result can significantly reduce the 

overall number of reporting cycles. 

The SHOUT nano saves valid ephemeris data after each 3D fix. The data is used to reduce 

acquisition time in the next reporting cycle from cold-start to hot-start. If the ephemeris data is 

older than two hours (time between reports is set for more than two hours), the GPS receiver 

will go through cold-start each time it wakes up to send a report. As a result, the SHOUT nano 

configured for a report rate of more than two hours and Standard Accuracy can only send 

approximately 750 tracking reports. Setting the Accuracy to Best also reduces the number of 

tracking reports to approximately 750 regardless of the report rate setting. 

IMPORTANT: Data presented here are only estimates and are highly dependent on the 

operating environment, accuracy setting, and antenna type. Data are based on measurements 

made with multiple SHOUT nano devices placed on the roof of NAL Research’s facility with no 

blockage. 

Each time the SHOUT nano wakes up to send a report, it has two minutes to acquire a GPS fix 

and send an Iridium SBD message. Assuming the ephemeris data is valid (less than two hours 

old or time-between-reports is less than two hours) and the Accuracy option is set to Standard, 

the GPS receiver takes about 10 seconds for a position fix drawing approximately 55 mA. The 

Iridium transceiver takes about 10 seconds to transmit an SBD message drawing an average 

current of 110 mA. The SHOUT nano circuit draws about 125 mA during a 25-second reporting 

cycle. The entire reporting cycle consumes approximately 1.32 mAh of battery power. If the 

Iridium antenna is blocked or an overhead Iridium satellite is not available, the Iridium 

transceiver can potentially stay on for another 100 seconds attempting to send a report. This 



This document contains NAL Research proprietary information which may not be 
used, reproduced, or disclosed without written approval from NAL Research 

 SHOUT nano User Guide Version B 

Document Number: 451-92681-001B 54 of 61 

results in additional consumption of 9.7 mAh or 11 mAh total. A missed report consumes 

approximately 8.5 times more power than a ‘normal’ transmitted report. 
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APPENDIX D: DESIGN SPECIFICATIONS 
The SHOUT nano comprises a 9602 Iridium modem, a u-blox GPS receiver, a GPS and an Iridium 

antenna, a Li-ion battery, an LCD, and an NAL Research controller board. It is designed to 

operate with the Iridium network using SBD only. 

D.1 MECHANICAL SPECIFICATIONS 
Dimensions:  ...................................................4.0” x 2.2” x 0.8” (102 mm x 56 mm x 20 mm) 

Weight:  ..........................................................~6.5 oz (184 g) 

Enclosure: .......................................................Hard anodized aluminum housing/EMI shielding 

Connector:  .....................................................USB 

Antennas: .......................................................Helix for Iridium and patch for GPS 

Keyboard: .......................................................Seven buttons 

Emergency: ....................................................Guarded button 

LED: ................................................................One status LED (power, tracking, and emergency) 

D.2 ELECTRICAL SPECIFICATIONS 
Main Input Voltage: .......................................3.0 VDC to 5.0 VDC 

Peak Current: .................................................1.5 A @ 4.2 VDC 

Battery Type: ..................................................Lithium-ion 

Battery Capacity: ............................................1.95 Ah 

Charging Voltage: ...........................................USB 1.0, USB 2.0 or 4–5 VDC 

Rechargeable Cycles: .....................................500 times 

Power Consumption: .....................................See Appendix C: Power Consumption 

Iridium Transceiver 

Operating Frequency: ....................................1616 to 1626 MHz 

Duplexing Method: ........................................TDD 

Multiplexing Method: ....................................TDMA/FDMA 

Link Margin Downlink: ...................................13 dB average (free space) 

Link Margin Uplink: ........................................7 dB average (free space) 
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GPS Receiver 

GPS Receiver: .................................................u-blox NEO-5Q or NEO-6Q 

Receiver Type: ................................................L1, C/A, 50-channel 

Update Rate: ..................................................4 Hz 

Accuracy: ........................................................2.5 m CEP (position) 

2.0 m CEP (SBAS) 

Acquisition: ....................................................29 seconds cold-start 

29 seconds warm-start 

<1 second hot-start 

Sensitivity: ......................................................–160 dBm (tracking) 

–160 dBm (reacquisition) 

–144 dBm (cold-start) 

D.3 ENVIRONMENTAL SPECIFICATIONS 

Electronics 

Operating Temperature: ................................–40°F to +185°F (–40°C to +85°C) 

Operating Humidity: ......................................≤ 75% RH 

Storage Temperature: ....................................–40°F to +185°F (–40°C to +85°C) 

Storage Humidity: ..........................................≤ 93% RH 

Battery 

Operating Temperature: ................................–4°F to +140°F (–20°C to +60°C) 

Operating Humidity: ......................................≤ 90% RH 

Storage Temperature: ....................................–4°F to +95°F (–20°C to +35°C) 

Storage Humidity: ..........................................≤ 95% RH 

Charge Temperature: .....................................32°F to +113°F (0°C to +45°C) 

LCD 

Operating Temperature: ................................–4°F to +131°F (–20°C to +55°C) 

Operating Humidity Range: ...........................≤ 90% RH 
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Storage Temperature Range: .........................–40°F to +185°F (–40°C to +85°C) 

Storage Humidity Range: ...............................≤ 95% RH 
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APPENDIX E: TECHNICAL SUPPORT 
For technical support, please contact us at: 

Phone: 571-833-2169 

Fax: 703-392-6795 

Email: Support@Nalresearch.com 

Technical documents are also available to download on NAL Research’s website 

www.nalresearch.com. 

mailto:Support@Nalresearch.com
https://www.nalresearch.com/
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APPENDIX F: STANDARDS COMPLIANCE 
The SHOUT nano has an internal Iridium 9602 transceiver. The 9602 is tested to the regulatory 

and technical certifications shown below. It is assigned to the FCC Identifier Q639602. The 

9602, and therefore the SHOUT nano, must not be readily accessible to human subjects closer 

than 20 centimeters. 

Regulatory 
Approvals Radio Tests EMC Tests Mechanical/ 

Electrical Tests 

FCC FCC CFR47 Parts 2, 
15, and 25  EN61000-4-2: 1995/A2:2001 Part 4.2  

Industry 
Canada 

Industry Canada 
RSS170 Issue 1, 
Rev 1, November 
6, 1999 

EN61000-4-3: 2002 Part 4.3 
EN61000-4-4: 1995/A1:2001/A2:2001 
Part 4.4 
EN61000-4-6: 1996/A1: 2001 Part 4.6 
EN55022: 1998/A1: 2000/A2: 2003 

 

CE ETSI EN 301 441 
V1.1.1 (2000-05) 

ETSI EN 301 489-1 V1.4.1 (2002-08) 
ETSI EN 301 489-20 V1.2.1 (2002-11) 

EN60950-1:2001 
Part 1 
UL60950-1 Part 1 
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APPENDIX G: EXPORT COMPLIANCE 
The SHOUT nano is controlled by the export laws and regulations of the United States of America 

(USA). It is the policy of NAL Research to fully comply with all U.S. export and economic sanction 

laws and regulations. The export of NAL Research products, services, hardware, software, and 

technology must be made only in accordance with the laws, regulations, and licensing 

requirements of the U.S. government. NAL Research customers must also comply with these laws 

and regulations. Failure to comply can result in the imposition of fines and penalties, the loss of 

export privileges, and termination of your contractual agreements with NAL Research. 

The export and re-export of NAL Research products and services are subject to regulation by the 

Export Administration Regulations (15 CFR 730-744), as administered by the U.S. Department of 

Commerce, Bureau of Industry and Security (BIS).  

See: https://www.bis.gov/ for further information on BIS and the Export Administration 

Regulations (EAR). Additional export restrictions are administered by the U.S. Department of the 

Treasury’s Office of Foreign Asset Controls (OFAC). See: https://ofac.treasury.gov/ for further 

information on OFAC and its requirements. 

 

https://www.bis.gov/
https://ofac.treasury.gov/
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APPENDIX H: MECHANICAL DRAWING 

 

Figure 27: SHOUT nano Mechanical Drawing 
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